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1 What's New in This Guide

A summary of recent changes to the Account Management for Workers guide.

Updated Date What's New More Information

November 2022 Added the 'Vertical Navigation' topic. FGL-95657
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2 Account Management

Once you've created your worker account, there are options to adjust your settings and update your account 
information.

When you're invited to create an account in SAP Fieldglass, you're asked to set up your credentials and then 
select some options for your account. After initial setup, you can make adjustments as needed. Some things to 
consider:

• When creating your account, the SAP Fieldglass password requirements display in the Log In Details 
section. You'll need to adhere to this password policy when setting your password.

• The languages available are based on the company's enabled system languages.
• Your preferences are specific to you. Company-wide settings, such as time zone and date format, may be 

different.
• After a certain amount of idle time, you're signed out. Approximately 90 seconds before the time-out, 

you're asked if you would like to keep working. If you don't respond, you're automatically signed out.
• To sign out, select your profile avatar and then select Log Out.

To sign back in to your account, you must provide your username and password. If you've forgotten either, you 
can use the In-App Assistant to help you retrieve the information. To access the assistant, select the Need Help 
Signing In? link on the sign-in page.

2.1 Home Page and Navigation
Once you've signed in to SAP Fieldglass, the Home page displays where you can create and manage your 
account-related content.

Your home page contains widgets that show actions you can take such as creating absences and expense 
sheets, as well as work items that require your attention including submitting time sheets or completing tasks.

Menus and Navigation
Use these menus to navigate to various areas in the application.

• Home - Use to navigate to your home page from anywhere in the application.
• View - Use to view existing documents such as time sheets, expense sheets, absences, and messages.
• Create - Use to create new documents such as expense sheets and absences.
• Help - Use to access product documentation, support documentation, and release communication. This is 

the (?) question mark icon on the top right.
• Settings - Use to view and update your account information, settings, and preferences. Icon to the right of 

the question mark. It has your initials or picture.

 Note
Note that if you choose the Vertical Navigation option, menu items display in a different format. See 
Vertical Navigation [page 5].
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Online Help and Support
The following support options are available:

• Updates to the application are available in the release communication document that's accessible from the 
home page link or via the help menu.

• To access documentation that can assist you in learning how to use SAP Fieldglass, select Product 
Documentation from the help menu.

• To access support documentation or to submit a support ticket, select Contact Us from the help menu.
• If you've forgotten your username or password, use the SAP Fieldglass In-App Assistant on the sign-in 

page to request your username or reset your password.

2.1.1  Vertical Navigation

The Vertical Navigation option provides an alternate way to navigate the SAP Fieldglass application, using a 
convenient side panel to house menu items.

The Vertical Navigation option displays categories and modules normally found on the View menu in a panel 
on the left-hand side of the application's Home page. It also places Messages in the header bar. To enable the 
Vertical Navigation option, select the View Feature Switch button (located in the top-right corner of the header 
bar) and select the Vertical Navigation option.

 Note
The categories displayed on the side panel are found on the View menu and Create menu when the Vertical 
Navigation option is disabled. Be aware that when reading documentation, steps may include navigating to 
the View or Create menus; however, using the Vertical Navigation option eliminates the need for this step, 
as all the categories are already conveniently displayed on the side panel.

The selectable categories are displayed on the side panel with corresponding icons. When a category on the 
panel is selected, it expands to show its respective modules in a list. When you select a module from that list, 
you're directed to that module's default page. Selecting the arrow located on the side panel collapses it to 
display categories as icons only. Selecting an icon opens the respective modules in a popup list.

The Create menu is accessed by selecting the Create button located under the side panel's categories. 
Selecting this opens the Create menu, which displays the Create modules.

The Help menu, normally found on the header bar, is located at the bottom of the side panel. Selecting the Help 
button expands to open a smaller panel with the Help menu options.

Account Management for Workers
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2.1.2  Completing Work Items

Work items are tasks that are assigned to you for completion.

Context

Work items that require your attention display in the Work Items to Act Upon widget on your home page.

 Note
Time sheets that need to be completed also display in this list. Refer to the Time and Expense 
Management for Workers guide for information on completing them.

Procedure

1. Select the work item link from the list. Details such as due date, prerequisites, frequency, etc. display.
2. Select Mark as Complete.
3. Enter the Completion Date and any Comments you wish to add.
4. Select Mark as Complete to complete the item.

2.1.3  Viewing Milestones

Milestones are events that are assigned to you for onboarding and assignment management.

Context

To view your milestones, select View Milestone  and then follow these steps:

Procedure

1. Select a milestone in the list to open it.
2. Milestones that require completion have a Mark as Complete button in the upper right corner. Select the 

button and then enter a completion date to mark the item complete.
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2.1.4  Viewing Messages

Messages are notifications that are sent to you related to tasks that require your attention, alerts about 
important information, and system broadcasts such as maintenance windows.

Context

Messages appear in the Message Center. Messages are color coded based on the type of notification: Alerts, 
Notifications, and System Broadcasts. You can filter the list by message type or message status (read or 
unread), or you can search messages text.

To view your messages, select View Messages  and then follow these steps:

Procedure

1. To view a message, click anywhere in the subject line. Unread messages display with bold text.
2. Review the message. Select Remove Message if you want to delete the message.
3. Select Next or Previous to navigate from one message to another.
4. Select Back to Messages to return to the message list.
5. Use the checkboxes in the list to Mark as Read or Remove Selected.

2.1.5  Selecting Favorite Tasks

Task codes that are assigned to you can be added to a favorites list so that they're easily accessible when 
entering time.

Context

To select your favorite tasks, use the Select Favorite Tasks option on the home page and then follow these 
steps:

Procedure

1. Select an assignment to get started. The Select Favorite Tasks form page displays.
2. Task codes that are assigned to you appear in the list. Select the codes you wish to add as favorites.

Account Management for Workers
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3. Select Add Selected to add the task codes to the Select Favorite Tasks list.
4. Select Update.

2.2 Profile and Preferences Settings

Your Settings allow you to personalize your profile, set Home page and application preferences, and view an 
organizational chart made up of users and workers in the SAP Fieldglass application.

Select the avatar or photo in the top right of the page to access the menu options under Settings:

• My Profile
• My Preferences

2.2.1  Your Profile Settings

On the My Profile page, you can view and edit your account information and manage your mobile app 
registration and authorized devices.

To access your profile settings, click your account menu icon from your home page, and select My Profile.

The My Profile page contains the following sections:

Contact Information

Contains your email address as well as personal and contact information. You can edit your email address and 
your physical address at any time.

Account Information

Contains your account credentials such as your username, password expiration, and your role. You can change 
your username and update your password as needed.

Linked Accounts

Contains a list of your linked accounts and also shows accounts that are linked to yours.

Mobile Apps

Contains a list of your registered devices if you're using the Time Entry mobile app. This is also where you 
generate a QR code to register new devices.
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Changing Your Username and Password

Update your username or change your password.

Context

To edit your username, select My Profile from the settings menu and click Edit in the Account Information 
section. Make the necessary changes and then click Update to complete the action.

A link to change your password is available in the Account Information section in your My Profile page. Note 
that you don't need to select Edit to complete this action. To change your password, select My Profile from the 
settings menu and then follow these steps:

Procedure

1. Select the Change Password link. The Change Password dialog box opens.
2. Enter your Current Password.
3. Enter your New Password.
4. Enter the new password again to confirm it.
5. Select Change.

Results

Your password is changed. If you've forgotten your username or password, use the SAP Fieldglass In-App 
Assistant on the sign-in page to request your username or reset your password.

Account Management for Workers
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Editing Your Contact Information

Update information such as your email address, physical address, and phone numbers.

Context

The section that is titled with your name is where you can update your basic information and your contact 
details. To update the information, select My Profile from the settings menu and then follow these steps:

Procedure

1. Select Edit. Your Basic Information and Contact Information displays on the page.
2. In the Basic Information section, update your Email address and/or add or remove CC Email Addresses.
3. In the Contact Information section, update or add your physical address and your contact phone numbers.
4. If desired, add or update your LinkedIn Profile URL. The URL you enter here is displayed as a link on your 

user profile and is visible to the supplier as well as the buyer company for whom you're working.
5. Select Update.

Results

The information is updated. Information such as your email address and contact details is also updated on your 
user profile that is visible to the supplier as well as the buyer company for whom you're working.

Managing Your Linked Accounts

You can manage accounts that are linked to this account, or add or remove accounts that are linked from this 
account.

Context

If you have multiple accounts, you can link to those accounts to make it easy to navigate back and forth 
between them. The Linked Account section contains options that allow you to add or remove linked accounts, 
enable or disable the ability for other accounts to link to this account, and add or remove accounts that are 
linked from other accounts.

Your linked accounts display in the account menu, which is available from your user icon on the home page. You 
can navigate back and forth between accounts by selecting an account from the list.

10 INTERNAL – Authorized for SAP Customers and Partners
Account Management for Workers

Account Management



 Note
You need the sign-in credentials for the accounts you want to add to your list of linked accounts.

To update your linked accounts, select My Profile from the settings menu and then follow these steps:

Procedure

1. Select Edit in the Linked Accounts section.
2. To add an account, select + Add Linked User Account.
3. Enter the Username and Password for the account you want to add.
4. Optionally enter a Nickname and Sort Order.
5. Enter the password for the account you're currently signed in to.
6. Select Add.

Results

The account is added to your list of Links from this User Account. A link to the account is available from your 
account menu on your home page.

Managing Your Mobile App Devices and Registration

View and remove registered devices or generate a QR code to register a new device.

Context

If you're using a mobile app, you can generate a QR code to register a new device or remove registered devices 
that you're no longer using. To register a new device, you need to download the desired mobile app on your 
device and initiate the registration process in the mobile app.

When you're ready to scan a QR code, you need to access the desktop application and navigate to your profile 
to generate a QR code. An option on your mobile device allows you to manually register a device without a QR 
code. To retrieve the necessary information for the manual setup, click the link in the text above the Generate 
QR Code button.

Account Management for Workers
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To remove registered devices, select My Profile from the settings menu and then follow these steps:

Procedure

1. Scroll to the mobile apps section and locate the mobile app you want to view.
2. Locate the device you want to remove in the list. Device Name, Device OS, Device Type, and Registration 

Date display for each registered device.
3. Click x Unregister next to the desired device. The Unregister Device dialog box displays.
4. Click OK to confirm the action.

Results

The device no longer appears in the list.

2.2.2  Editing Your Preferences

Your account preferences include settings for locale, home page and application, and messaging.

Context

To update your preferences, select My Preferences from the settings menu and then follow these steps:

Procedure

1. To edit your locale settings, select Edit in the Locale area and make adjustments as needed. You can 
change your preferred time zone, language, date format, time format, number format, and start day of 
week.

2. To edit your home page, select Edit in the Home Page and Application Settings area and make 
adjustments as needed. You can change the color theme and you can show or hide the widgets that 
appear on your home page.

3. To adjust your messaging settings, select Edit in the Messaging area and make adjustments as needed. 
You can change your preferred email format and choose which types of messages you want to receive 
emails for.
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2.3 Absences

SAP Fieldglass provides tools that allow you to notify your management when you're absent and when you plan 
to be absent.

If the buyer company allows you to submit absences, you're provided with an option to create and submit your 
time-off. You can submit and view your absences from your account at any time. To view absences that you've 
already submitted, select View Absence  and select one from the list.

This information is informational only and doesn't require approval.

2.3.1  Submitting Absences

You can create and submit absences directly from your home page or via the Create menu.

Context

To create an absence, select Create Absence  and then follow these steps:

Procedure

1. Enter the Start Date and End Date. To enter a single day or a partial day, enter the same date in both 
fields.

2. Select a Reason.
3. If you're entering a partial absence, select Yes for Partial Day and then enter the Duration in hours and 

minutes.
4. Select Submit.

Account Management for Workers
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Important Disclaimers and Legal Information

Hyperlinks
Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

• Links with the icon : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your 
agreements with SAP) to this:

• The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.

• SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any 
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

• Links with the icon : You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using 
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this 
information.

Videos Hosted on External Platforms
Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any 
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within 
the control or responsibility of SAP.

Beta and Other Experimental Features
Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by 
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use 
the experimental features in a live operating environment or with data that has not been sufficiently backed up.
The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your 
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code
Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax 
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of 
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language
SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities, 
genders, and abilities.
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www.sap.com/contactsap

© 2022 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form 
or for any purpose without the express permission of SAP SE or an SAP 
affiliate company. The information contained herein may be changed 
without prior notice.

Some software products marketed by SAP SE and its distributors 
contain proprietary software components of other software vendors. 
National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company for 
informational purposes only, without representation or warranty of any 
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omissions with respect to the materials. The only warranties for SAP or 
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additional warranty.
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